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Guia prático para configuração, coleta e 
utilização de oscilografias em relés digitais 

 
Rafael Cardoso 

 
 

1. OBJETIVO: 
 

Este guia de aplicação tem o objetivo de apresentar uma importante ferramenta 
disponível nos relés digitais, a oscilografia. Neste guia de aplicação, serão tratados 
os conceitos de oscilografias filtradas e não-filtradas, duração dos registros, 
resolução, disparo de gravação manual e automático, coleta e armazenamento, 
formato do arquivo e análise da ocorrência. 

 
2. INTRODUÇÃO: 

 
Oscilografia é um registro das grandezas elétricas analógicas e digitais do 

sistema de potência, armazenados de forma automática ou manual nos relés digitais 
de proteção.  

 
No registro manual, o processo de gravação inicia por demanda do usuário e 

normalmente serve para analisar condições operativas do sistema elétrico no 
instante de interesse do usuário. 

 
As gravações automáticas ocorrem por programações efetuadas pelo usuário do 

relé digital. O processo inicia através de mudanças de valores analógicos ou estados 
digitais em consequência de disparos de proteção ou variações de grandezas 
elétricas.  

 
Durante as perturbações no Sistema Elétrico, os relés digitais gravam os registros 

das variações ocorridas em memórias internas não voláteis. Os registros 
armazenados em arquivos possibilitam analisar a operação do relé, identificar o tipo 
de defeito, as fases que foram envolvidas, definir os tempos da ocorrência de 
mudanças de estado ou valores analógicos, localizar o ponto de ocorrência da falta, 
analisar a coordenação da proteção, entre outros aspectos específicos de cada 
caso. 
 

3. CONCEITOS: 
 

3.1.  QUANDO AS OCILOGRAFIAS SÃO GERADAS? 
 

As oscilografias são armazenadas pelo relé nas seguintes situações: 
 

- Disparo da proteção (trip); 
- Partida de registro programado; 
- Partida de registro manual. 
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Disparo da proteção se refere à atuação do relé ou trip. Neste caso, a oscilografia 
é armazenada automaticamente sempre que for sensibilizada uma das funções de 
proteção, que esteja previamente programada para realizar a partida do registro 
oscilográfico. Este tipo de disparo está vinculado à lógica de trip e as funções ali 
parametrizadas serão responsáveis por disparar a gravação do arquivo. A figura 01 
mostra a equação lógica de trip como exemplo para o relé SEL-751A. 
 
 
 

 
Figura 01 – Equação lógica de trip 

 
 

Partida de registro programado é um parâmetro ajustável que permite ao 
usuário escolher condições diversas para iniciar o armazenamento do registro de 
uma oscilografia. Pode-se programar a partida de uma função de sobrecorrente 
(pickup), o alarme de uma função de desbalanço, o alarme por temperatura elevada, 
a energização de um transformador entre outros eventos. 

 
Vemos na figura 02 a equação lógica de disparo programado do SEL-751A. 

Observa-se a configuração de variáveis de partida de proteção, como por exemplo, 
51P1P (partida de sobrecorrente temporizada de fase). 

 
O operador R_TRIG, inserido à frente de cada variável, é o detector de 

transição de estado lógico 0 (não-atuado) para 1 (atuado). Com esta configuração 
será gerado apenas um pulso na equação de disparo.  
 

 
Figura 02 – Equação lógica de disparo programado (ER) 

 
Partida de registro manual é um comando executado pelo operador que fará o 

relé armazenar a oscilografia das condições atuais do sistema. Esse disparo é 
realizado, por exemplo, quando se deseja observar a diferença angular dos fasores 
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de corrente e tensão, analisar inversões na conexão dos transformadores de 
corrente e investigar componentes harmônicas. Existem diferentes maneiras de fazer 
o disparo manual, sendo elas: 
 

a) Partida manual através da interface homem-máquina do AcSELerator 
QuickSet 

 
 

 
Figura 03 – Acesso à interface homem-máquina – HMI 

 
 

 
Figura 04 – Botão “Trigger” 

 
 
 

b) Partida manual através do menu de eventos do AcSELerator QuickSet 
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Figura 05 – Acesso ao menu de eventos 

 
 

 
Figura 06 – Botão “Trigger New Events” 
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c) Partida manual através do terminal de comunicação 

 
 

 
Figura 07 – Acesso ao terminal de comunicação 

 
 

 
Figura 08 – Comando “Trigger” no terminal 

 
 

3.2. DURAÇÃO 
 

A duração da oscilografia corresponde ao tamanho do registro, em uma janela de 
tempo, armazenado no arquivo pelo relé. O tamanho é medido em número de ciclos 
da onda que serão gravados em cada evento. É um parâmetro ajustável, com 
diferenças conforme o modelo do relé e poderá ser de 15 ciclos até 720 ciclos (12 
segundos). Uma parcela desse tempo é reservada para o tempo de registro de pré-
falta que é também configurável. 

 
A capacidade de armazenamento total, ou seja, a memória para gravar as 

oscilografias é fixa para cada equipamento. Quanto maior for o ajuste da duração, 
menor será o número de eventos gravados. Quando a capacidade máxima for 
atingida o relé irá apagar o evento mais antigo para gravar o evento mais novo.  

 
Vamos observar as opções de dois modelos: 
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SEL-751A 
 
Neste relé é possível selecionar 15 ou 64 ciclos. Na configuração com 15 ciclos 

ele terá capacidade de armazenar os últimos 23 eventos. Se configurado com 64 
ciclos, ficarão armazenadas as últimas 7 oscilografias.  

 
Na figura 09 vemos o parâmetro “LER” aonde se ajusta a duração total da 

oscilografia e o parâmetro “PRE” para configuração da duração da pré-falta. 
 

 
Figura 09 – Ajuste da duração do evento no SEL-751A 

 
SEL-451-5 
 
Este relé possui maior capacidade de armazenamento de arquivos e permite a 

escolha entre 0,25 até 12 segundos. Sua memória pode armazenar até 24 segundos 
de dados. 

 

 
Figura 10 – Ajuste da duração do evento no SEL-451-5 

 
3.3.  RESOLUÇÃO 
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A resolução da oscilografia corresponde ao número de amostras por ciclo. Este 

parâmetro pode ser fixo ou ajustável em alguns relés. 
 
SEL-751A 
 
A resolução é de 4 amostras/ciclo ou de 16 amostras/ciclo. A escolha é feita ao 

capturar a oscilografia da memória do relé, isto é, não é um parâmetro da ordem 
ajustes. 

 
SEL-451-5 
 
Neste modelo a resolução é um parâmetro que deve ser ajustado pelo usuário. 

Existem quatro opções: 1, 2, 4 ou 8 kHz. Esse último corresponde a uma resolução 
de 8000 amostras/segundo.  

 

 
Figura 11 – Ajuste da resolução no SEL-451-5 

 
Ao relacionar os parâmetros resolução e duração chegamos à figura 12 que 

apresenta o número máximo de oscilografias gravadas na memória do relé SEL-451-
5. 

 
Figura 12 – Duração x Resolução 

 
3.4.  FILTRADA OU NÃO-FILTRADA? 
 

Duração
[segundos] 8 kHz 4 kHz 2 kHz 1 kHz

0.25 128 170 203 239
0.5 71 98 123 149
1 37 54 68 84
3 13 19 24 31
6 ‐ 9 12 16
12 ‐ ‐ 6 8
24 ‐ ‐ ‐ 4

Número máximo de eventos em memória
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As formas de onda brutas de corrente e tensão em um sistema elétrico podem 
ser representadas pela composição de diversas ondas. Às grandezas na frequência 
fundamental do sistema (60Hz no Brasil) são somados os diversos componentes 
harmônicos, DC e ruídos de alta frequência. Durante uma ocorrência no sistema, as 
contribuições de cada componente se alteram resultando na forma de onda final 
medida pelo relé digital. 

 
Para a atuação de funções de proteção que são sensibilizadas pelas variações 

da componente fundamental, o relé digital precisa tratar o sinal medido. Ele deve 
extrair apenas a parcela de interesse e para isso são usados os filtros. 

  
Os filtros são responsáveis por preparar os sinais amostrado, provenientes dos 

transformadores de instrumento, e entregá-los ao processador para uso nos 
algoritmos da proteção. 

 
Após as correntes e tensões terem sido reduzidas para níveis aceitáveis pelos 

transformadores de instrumento, os sinais são filtrados através de um filtro analógico 
passa-baixas que rejeita harmônicos maiores. Em seguida, os sinais são 
digitalizados e re-filtrados através de um filtro digital. Grandezas de operação 
numéricas são então calculadas a partir das formas de onda processadas.  

 

 
Figura 13 – Processamento do sinal 

 
O usuário ao fazer a coleta dos eventos, tem a oportunidade de escolher entre a 

oscilografia filtrada (usada no algoritmo de proteção) e a não-filtrada (sinal bruto). É 
interessante que ele faça sempre a captura dos dois tipos.  
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Figura 14 – Sinal bruto x Sinal filtrado 

 
Com a oscilografia filtrada será possível analisar a operação do relé e com a não-

filtrada visualizar harmônicos do sistema de potência, saturação de TC e offset DC.  
 
O processo de captura dos eventos será apresentado no decorrer deste guia. 

 
 

3.5.  FORMATO 
 

Os dados das ocilografias estão no formato comprimido com extensão CEV ou no 
formato COMTRADE com as extensões DAT, HDR e CFG.  

 
Ambos os formatos podem ser visualizados no computador através dos softwares 

AcSELerator QuickSet ou AcSELerator Analytic Assistant.  
 
O formato COMTRADE poderá ser útil se o usuário desejar reproduzir novamente 

as formas de onda no relé de proteção. Isto é possível com a utilização de modernas 
caixas de injeção de corrente e tensão disponíveis no mercado, as quais 
reconhecem os sinais da oscilografia COMTRADE e reproduzem os mesmos sinais 
analógicos em seus terminais.  

 
3.6.  CONTEÚDO 
 
Os dados incorporados em uma oscilografia são: 
  

 Grandezas analógicas de corrente e tensão; 
 Estados digitais dos elementos de proteção e controle e entradas/saídas 

digitais;  
 Sumário do evento (data, hora, tipo de falta, correntes de falta e 

localização da falta); 
 Parâmetros de ajuste do relé. 

 
 
4. SOFTWARE DE COLETA E ANÁLISE: 
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Utilizaremos neste guia o software AcSELerator QuickSet (SEL-5030) cujo 

download pode ser feito diretamente no website da SEL (www.selinc.com.br). Este 
software permite a configuração, leitura e envio de ajustes, atualização de firmware, 
monitoramento do relé pela interface homem-máquina, além de possibilitar a coleta e 
análise de oscilografias. Para essa última função ele incorpora uma versão 
demonstração do software Analytic Assistant (SEL-5601). 

 
Trataremos inicialmente das instruções para comunicação entre computador e 

relé, em seguida do processo de captura da oscilografia e finalmente da análise. O 
tópico de comunicação será subdivido para discutirmos separadamente as opção de 
comunicação serial e ethernet. 

 
4.1. COMUNICAÇÃO 
 
Os parâmetros de comunicação são configurados no menu:  
 
Communications → Parameters. 
 
 

 
Figura 15 – Acesso aos parâmetros de comunicação 

 
 
4.1.1 COMUNICAÇÃO SERIAL 
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Figura 16 – Parâmetros da comunicação serial 

 
 

Passo 1:  Selecionar a interface de comunicação “Serial”. 
Passo 2:  Selecionar a porta de comunicação. Para computadores com porta 

serial normalmente esta aparecerá como COM1. Os computadores 
que não dispõem desta porta precisarão de um cabo conversor de 
USB para Serial, e nesse caso a porta poderá aparecer com outros 
números, exemplo: COM3. 

Passo 3:  Selecionar as configurações da porta do computador. Nesse passo é 
necessário ajustar a porta do computador exatamente como foi 
ajustada a porta do relé. Para facilitar selecione a opção “Auto 
Detect”. 

Passo 4:  Preencher os campos de senha. Na fábrica o relé é ajustado com as 
seguintes senhas: 

 
Senha padrão de visualização: OTTER  
Senha padrão de parametrização: TAIL 
As senhas padrões da SEL podem ser alteradas pelo usuário. 

 
 

4.1.2 COMUNICAÇÃO ETHERNET 
 
 

 

 

 

 

2

1

3

4
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Figura 17 – Parâmetros da comunicação ethernet 

 
 

Passo 1:  Selecionar a interface de comunicação “Network”. 
Passo 2:  Digitar o endereço IP e a porta Telnet do relé.  
Passo 3:  Selecionar o tipo de transmissão de arquivos “FTP” e preencher os 

dados de acesso. No campo “User ID” informar o nome do usuário 
FTP que foi parametrizado no relé. Usualmente em relés da série 
700 utiliza-se o nome “FTPUSER” e na série 400 o nome “2AC”. Em 
ambos os casos a senha padrão configurada na fábrica é “TAIL”. 

Passo 4:  Este item só deverá ser preenchido em caso de conexão Telnet. Na 
fábrica as senhas configuradas são: 

 
Senha padrão de visualização: OTTER  
Senha padrão de parametrização: TAIL 
As senhas padrões da SEL podem ser alteradas pelo usuário. 

 
 

4.2. COLETA 
 
A coleta das oscilografias é feita no menu: 
 
Tools → Events → Get Event Files 
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Figura 18– Acesso à janela de captura de eventos 

 
Será apresentada a janela com o histórico dos eventos conforme demonstrado 

abaixo: 
  

 
Figura 19 – Janela de eventos 

 
Passo 1:  Selecionar o evento de interesse. 
Passo 2:  Escolher o tipo de arquivo para coleta.  
  

IMPORTANTE:  As oscilografias não filtradas aparecerão como 
“RAW” ou “COMTRADE”. As demais opções serão oscilografias 
filtradas. 

 
Passo 3: Clicar no botão “Get Selected Events” 
 
Após esta etapa será solicitado pelo software que o usuário determine uma pasta 

para salvar o arquivo no computador e um nome para o mesmo. 
 

1
2

3
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Figura 20– Salvar o evento 

 
 

4.3. ANÁLISE 
 
A análise das oscilografias é feita no menu: 
 
Tools → Events → View Event Files 
 
 

 
Figura 21– Acesso à análise de eventos 

 
Após clicar neste item, devemos indicar o arquivo que desejamos analisar.  
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Figura 22 – Abrir o evento 

 
Tendo selecionado o arquivo, clicamos em “Abrir” e veremos a janela principal. 
 
 

 
 

Figura 23 – Janela principal do evento 
 

 
1. Tipo da falta 
2. Sinalização das funções de proteção 
3. Correntes de falta 
4. Localização da falta 
5. Número de disparos do religamento 
6. Frequência 
7. Data e hora 

 
 Os recursos disponíveis são: 
 
4.3.1 CONFIGURAÇÕES 
 
Os parâmetros do software devem ser configurados no menu: 
 
Options. 

 

7 
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Figura 24 – Botão de opções 

 
 

 
Figura 25 – Opções do usuário 

 
 

1. Converte a oscilografia do formato CEV em COMTRADE. Obs: o arquivo 
COMTRADE ficará salvo na mesma pasta aonde foi salvo o arquivo CEV. 

2. Rotação de fases 
 
4.3.2 GRÁFICO 
 
Veremos as formas de onda dos sinais analógicos e digitais através do menu: 
 
View → Graph  .   
 

 
Figura 26 – Acesso ao gráfico 

 

1

2
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Figura 27 – Gráfico com as formas de onda 

 
 
Com o botão “Pref” ajustaremos a forma de visualização.   
 

 
Figura 28 – Parâmetros do gráfico 

 
1. Grandezas analógicas 
2. Variáveis digitais 
3. Exibir apenas variáveis ativas 
4. Selecionar analógicas (clique, segure e arreste usando o botão direito) 
5. Selecionar digitais (clique, segure e arreste usando o botão direito) 
6. Ajustar o número de ciclos que será exibido 
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Figura 29 – Gráfico com sinais analógicos e digitais 
 
 

1. Grandezas analógicas exibidas em valores eficazes 
2. Variáveis digitais 
3. Partida da proteção (pickup) 
4. Atuação da proteção (trip) 
5. Abertura do disjuntor 

 
Podemos verificar o tempo de atuação da proteção. Com o cursor do mouse 

devemos marcar o primeiro ponto e apertar a tecla F3. Em seguida, marcamos o 
segundo ponto e apertamos F4. 
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Figura 30 – Atuação da proteção 

 
 
Podemos também ver o tempo de eliminação da falta, desde a partida do relé até 

a abertura do disjuntor. 
 

 
Figura 31 – Abertura do disjuntor 

 
 
 
 
4.3.3 FASORES 
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Esse recurso permite a visualização do diagrama fasorial das grandezas 
analógicas. 

 

 
Figura 32 – Acesso aos fasores 

 
 

 
Figura 33 – Diagrama fasorial 

 
1. Magnitude e ângulo dos fasores 
2. Fasor de referência 
3. Seleção do ciclo 
4. Fasores das componentes de fase 
5. Fasores das componentes simétricas 
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4.3.4 COMPONENTES HARMÔNICAS 
 
A utilização desse recurso estará disponível apenas para as oscilografias não-

filtradas (RAW). 
 

 
Figura 34 – Acesso às componentes harmônicas 

 
 

 
Figura 35 – Análise de harmônicas 

 
1. Grandeza analógica selecionada 
2. Componentes harmônicas 
3. Porcentagem da componente fundamental 

 
 
4.3.5 AJUSTES DO RELÉ 
 
Os ajustes da proteção também fazem parte do arquivo da oscilografia e serão 

úteis para o usuário entender o porquê da atuação do relé. Se os ajustes foram 
alterados desde a data do evento até o momento da captura do arquivo, aparecerá a 
seguinte mensagem informando essa mudança: “SETTINGS CHANGED SINCE 
EVENT”.  
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Figura 36 – Acesso aos ajustes do relé 

 

 
Figura 37 – Ajustes do relé 

 
5. CONCLUSÃO: 

 
 Os registros de oscilograficas dos relés digitais oferecem aos engenheiros de 

proteção a oportunidade de estudar e compreender as ocorrências no sistema de 
potência, bem como, analisar se a proteção foi ajustada de forma satisfatória.  

 
O relé exige poucas configurações relacionadas às oscilografias e dentre elas 

destacamos a duração dos registros, pois esse parâmetro influenciará no número de 
arquivos que poderão ficar armazenados na memória do equipamento. 

 
A coleta e análise dos arquivos podem ser realizadas com software gratuito, de 

fácil utilização e com todos os recursos necessários.  
 


